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Information is organized in the following topics:

15Appendix A - Disconnecting a Remote DNC Channel . . . . . . . . .

14Sending BTR Configuration4.5 . . . . . . . . . . . . . . . . . . . . . . . . . .

13Sending Component Version Information4.4 . . . . . . . . . . . . . . .

11Sending Captured CNC Output4.3 . . . . . . . . . . . . . . . . . . . . . . .

8Sending Files4.2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

6Sending Screen Image4.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

6Sending Information to Dostek4 . . . . . . . . . . . . . . . . . . . . . .

5Resolving an After-hours Emergency3.3 . . . . . . . . . . . . . . . . . .

5Resolving CNC Communication Problems3.3 . . . . . . . . . . . . . . .

4Resolving Software Problems3.2 . . . . . . . . . . . . . . . . . . . . . . . .

4Resolving Installation Problems3.1 . . . . . . . . . . . . . . . . . . . . . .

4Resolving Problems3 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3Understanding Support Options2 . . . . . . . . . . . . . . . . . . . . . .

2Contacting Dostek1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

C O N T E N T S

Notes:

› Dostek technical support is available during normal business hours. To ensure you
can quickly get your DNC system working when you experience a computer failure
after hours, prepare and test a back-up computer ahead of time.

› If you are using Dostek DNC 2009 or earlier, note that some Dostek DNC applica-
tions use slightly different names in previous versions.

DMDNC32DRemote

DTerm32DTerminal

DEdit32DEditor

DDFM32DFileMgr

2009 and Earlier2010 and Later
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1 Contacting Dostek

To obtain fast and accurate technical support from Dostek, review these tips:

• Review the recommendations for resolving problems provided in Section 2,
"Resolving Problems."

• Write down your observations, including all alarm codes and error messages, and
a brief description of exactly what you were doing when the problem occurred. 

• Provide an accurate description of the problem, being specific and avoiding slang
and ambiguous words. For example, instead of saying "It quits when I download,"
say "When I'm sending a file from the computer to the CNC, the CNC indicates
alarm 86 and the Dostek DNC software stops after sending 14 percent of the file
and displays the message "XOff char received."

• Whether you contact Dostek by telephone, fax or e-mail, be sure to provide your
complete contact information including:

¤ Your full name
¤ Your company name (required to locate your file)
¤ Your telephone number, including area code
¤ Your correct e-mail address
¤ Your Dostek DNC software version number (Dostek DNC Navigator,

About tab)

www.dostek.com/supportInternet

519-741-8669Facsimile

888-355-5735 (Toll free, USA and Canada)
519-742-5721
8am - 5pm EST, Monday to Friday

Telephone

support@dostek.comE-mail
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2 Understanding Support Options

This section explains Dostek support options:

• Web-based remote support and training

• Telephone support

• E-mail support

Note:

› Telephone and Web-based remote support are free during your free trial period,
and for a limited time after your purchase.

Web-based Remote Support and Training

Web-based remote support and training is fast, secure and cost-effective way to put
Dostek's technical expertise to work for you. All you need is a high-speed Internet
connection. We can remotely install and configure your software, provide training or
solve technical problems. 

Remote support is easy: 

1. Visit the Support page on the Dostek Web site (www.dostek.com/support)

2. Call Dostek to obtain a remote support session ID.

3. Type your session ID in the space provided on the Dostek Support page, and
then click Connect. 

4. Follow the on-screen instructions to install the remote support software and
connect with Dostek technical support.

Telephone Support

Limited telephone support is available. For best results, choose Web-based remote
support.

E-mail Support

E-mail support is always free to registered users. 

Online Help

Dostek DNC includes extensive online help documents to help you resolve problems.
To access help, use the Help menu in any Dostek DNC application, or select the Help
tab in the Dostek DNC Navigator application. For help with communication problems,
open the Communication Testing and Troubleshooting help document, select
Problem Topics in the Contents window, and find the topic that best describes your
problem.
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3 Resolving Problems

This section helps you with:

3.1 - Resolving installation problems

3.2 - Resolving software problems

3.3 - Resolving CNC communication problems

3.1 Resolving Installation Problems

If you encounter a problem while installing the Dostek DNC software:

 Write down, print or save a screen image of every error message (see
Section 5, "Send Screen Image to Dostek."

 To install the software, log on to your computer using an account with
administrator privileges.

 Ensure that all other Windows applications are closed before starting the
installation. 

 Carefully read and follow all messages and instructions displayed on your
computer screen during installation. 

 Fully complete the Dostek DNC First-Time Setup Wizard. It starts
automatically when the software installation is completed. 

 Try installing Dostek DNC on a different computer. There may be a problem
with your computer. Windows computers can become unstable over time due
to viruses, spyware, registry corruption, installation of non-compliant
applications, and so on.  

3.2 Resolving Software Problems

If you encounter a problem when you start the Dostek DNC software or perform a
specific task:

 Write down, print or save a screen image of every error message (see
Section 5, "Send Screen Image to Dostek."

 Write down exactly what you were attempting to do when the problem
occurred, including the commands or key sequences you pressed.

 Restart the computer and try again. Windows computers can become
unstable or low on resources.

 Ensure the computer's disk drive is not full.

 If you are attempting to access files on a network resource, ensure the
network is working properly and you have sufficient network privileges.
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3.3 Resolving CNC Communication Problems

If you encounter a problem when you upload, download or drip feed:

 Write down, print or save a screen image of every error message (see
Section 5, "Send Screen Image to Dostek") displayed by the software or by
the CNC.

 If the CNC displays an alarm, find the alarm description in the CNC manual
and write it down or make a copy of the manual page.

 Use the sample device configuration provided for your CNC, and carefully
read the notes provided in the "Notes" tab. To use a sample configuration:

a) Start the Dostek DNC Configuration application.
b) On the File menu, click Import sample configuration.
c) Click the Notes tab and read the comments and instructions.

 Keep notes. Before you change anything (on the computer or the CNC), write
down the current setting, the new setting, and the reason for the change.

 View the Communication Testing and Troubleshooting help file (Navigator
Help tab) for detailed recommendations for typical communication problems.
Go to the Problem Topics section and find the topic heading that most
closely describes your problem.

3.4 Resolving an After-hours Emergency

To quickly resolve an emergency (such as a computer failure) when Dostek technical
support is not available:

• Plan ahead. Prepare a back-up computer.

¤ Test your backup computer periodically to ensure it works when you
need it.

¤ Use a laptop for your backup computer. You can connect a laptop directly
to any CNC to work around problems with your computers, communica-
tion hardware or cables.

• If you failed to plan ahead, install your Dostek DNC software on a new computer.
If you can't find your Dostek DNC software disk, download the free trial copy from
the Dostek Web site. 

• If your software works, but you are having problems communicating with your
CNCs, see the Dostek DNC Communication Testing and Troubleshooting help file.
This help file explains how to test ports and cables ("Procedures" section), and
provides solutions to common problems ("Problem Topics" section). To find the
help file,  see the Help menu in Dostek DNC File Manager, or the Help tab in
Dostek DNC Navigator. 
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4 Sending Information to Dostek

This section helps you with:

4.1 - Sending screen images

4.2 - Sending files

4.3 - Sending captured CNC output

4.4 - Sending component version information

4.5 - Sending BTR configuration

4.1 Sending Screen Images

To capture a screen image (such as an error message) and send it to Dostek:

1. Press the computer's PrtScrn key. A snapshot of the current screen image is
saved to the Windows Clipboard.

Note: To save a snapshot of only the current window (not the entire screen),
press Alt+PrtScrn.

2. On the Windows Start menu, click Run.  The Run dialog box appears.

3. Type MSPAINT and then press Enter. The Windows graphic editor window
opens.

4. Press Ctrl+V. The captured screen snapshot is pasted into Windows Paint. 

5. On the File menu, click Save as. The Save As dialog box appears:
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6. On the "Save As" dialog:

a) Select a file location using Save in. [1]

b) Type a file name in the File name box. [2]

c) Select "JPEG" in Save as type. [3]
Selecting "JPEG" reduces the size of the file so it is easier to send by
e-mail.

d) Click Save. The file is saved. [4] 

7. On the File menu, click Send. A new message is opened in the computer's
e-mail client. Type support@dostek.com in the To box.

Note:

› If an e-mail client is not installed, see Section 3.2, "Sending Files."
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4.2 Sending Files

This section explains how to send files to Dostek, including:

• Dostek DNC configuration files

• Dostek DNC log files

• Data files

• Dostek MultiPort DNC messages

• Dostek MultiPort DNC received file

• Dostek MultiPort DNC feedback message file

To send files to Dostek, attach the files to an e-mail message addressed to
"support@dostek.com".

If your computer does not have an e-mail client installed, copy the files to another
computer using a USB memory device, a removable disk, or a shared network folder.

Sending Dostek DNC Configuration Files

To send Dostek DNC configuration files to Dostek:

1. Start the Dostek DNC Configuration application.

2. On the File menu, point to Explore and then click Dostek DNC\Settings. A
new Windows Explorer window opens in the Dostek DNC "Settings" folder.

3. Select one or more files, or press Ctrl+A to select all files.

4. On the Explorer File menu, point to Send and then click Mail Recipient. A new
e-mail message is opened, with the selected files attached.

Note:

› If the computer does not have an e-mail client installed, on the Explorer menu
click Edit, Copy to folder and browse to select a network folder or removable
media on which to store the files.

Sending Dostek DNC Log Files

To send Dostek DNC log files to Dostek, follow the same procedure as the previous
section, except click Dostek DNC\Log in step #2.   
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Sending Data Files

To send data files to Dostek:

1. Right-click the Windows Start button, and then click Explore in the context
menu. A new Windows Explorer window opens.

2. Browse to the folder containing the data files you wish to send.

3. Select one or more data files.

4. On the Explorer File menu, point to Send and then click Mail Recipient. A new
e-mail message is opened, with the selected files attached.

Notes:

› If the computer does not have an e-mail client installed, on the Explorer menu
click Edit, Copy to folder and browse to select a network folder or removable
media on which to store the files.

› If you are sending a large number of files, or files that are very large, use WinZip
(or similar) file compression software to condense and combine the files into a
single file.

Sending Dostek DNC Remote Server Messages

To send Dostek DNC Remote Server message and log files:

1. From the Dostek DNC Remote Server application (DRemote) menu, click Help,
Copy messages to clipboard. All recent messages are copied to the Windows
Clipboard. 

2. Open a new e-mail message, and then paste the messages from the Windows
Clipboard into the message.

Notes:

›  If the computer does not have an e-mail client installed, open a new Notepad or
Word document and then paste the messages into the new document. Save the
document to a file, and copy the file to another computer using a removable disk
or shared network folder.

› To send recent messages for one specific CNC only:

a) Select the CNC in the DRemote application's CNC list.

b) On the menu, click Channel, point to View and then click
Messages.          
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Sending Dostek DNC Remote Server Received File

To send the content of the most recently received file for a specific CNC: 

1. Select the CNC in the DRemote application's CNC list.

2. On the menu, click Channel, point to View and then click Last received file.
The most recently received file is displayed in the view window. 

3. Open a new e-mail message, and then paste the messages from the Windows
Clipboard into the message.

Note:

› If the computer does not have an e-mail client installed, open a new Notepad or
Word document and then paste the messages into the new document. Save the
document to a file, and copy the file to another computer using a removable disk
or shared network folder.

Sending Dostek DNC Remote Server Feedback Message File

To send the most recent feedback message sent by the Dostek DNC Remote Server
application to a specific CNC:

1. On the DRemote menu, click Tools, and then point to Explore, and then click
Dostek DNC\Log. A new Windows Explorer window opens in the Dostek DNC
Log folder.

2. Select the .fbk file (file with extension ".fbk") matching the name of the CNC.

3. On the Explorer File menu, point to Send and then click Mail Recipient. A new
e-mail message is opened, with the selected file attached.

Note: If the computer does not have an e-mail client installed, on the Explorer
menu click Edit, Copy to folder and browse to select a network folder or
removable media on which to store the files.
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4.3 Sending Captured CNC Output

This section explains how to:

• Capture data sent from the CNC to the computer using the Dostek DNC Com Test
Terminal application (DTerminal).

• Send the captured data to Dostek.

To capture data sent by the CNC and send it to Dostek:

1. Start the Dostek DNC Com Test Terminal application (DTerminal):

a) If you are using the Dostek DNC File Manager (DFileMgr), on the
Supervisor menu, click Com Test Terminal. 

b) If you are using the Dostek DNC Remote Server (DRemote), on the
Tools menu, click Com Test Terminal. Note: You must first
"disconnect" the channel as explained in Appendix A, "Disconnecting
a MultiPort DNC Channel."

The DTerminal Device Configuration window opens. 

2. Select the configuration for the CNC you wish to receive data from, and then
click OK. 

3. An additional information message may appear. Click OK. The DTerminal window
opens with the title "COMn - DTerminal - Dostek DNC Com Test Terminal"
(where "COMn" is the selected COM port).

Note:

› When DTerminal opens the selected COM port, the status panel at the
bottom left corner of the window indicates "Connected" on a green
background. If the status indicates "Disconnected" on a red background,
DTerminal is unable to open the COM port. This could mean the port is
already in use by another application, or the port is not configured properly.
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4. Configure the DTerminal Options menu as shown below, and set Flow Control
in the toolbar to None.

5. On the DTerminal menu, click File, and then Capture to log file. The "Open
communication log file" window opens.

6. Select an existing log file, or type the name of a new log file, and then click OK.

Note: Use the extension .log or .txt for the log file. This makes it easier to open
the file in a text editor or attach it to an e-mail message.

7. Go to the CNC and send the data you wish to capture. Captured data scrolls in
the DTerminal window, and usually appears something like the example below: 

Note: Control characters (such as "Line Feed") that are not normally visible are
displayed as a two-character 'control-code' sequence. For example, the NULL
character which is used by some CNCs to produce blank tape on a paper tape
punch is displayed as "^@", and the LF (Line Feed) character designated as the
"End of Block" code in ISO-standard G-code programs is displayed as "^J". 

8. On the DTerminal menu, click File, and then Capture to log file again to stop
capturing data. The "End capture" prompt appears.
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9. Click a button to choose what to do with the captured data. To send the captured
data to Dostek by e-mail:

a) Click Clipboard to copy the captured data to the Windows clipboard.
b) Open a new e-mail message, and then paste the captured data into

the e-mail message.

Note:

› If the computer does not have an e-mail client installed, save the copy the
captured file to another computer by a removable drive or a shared network
folder.

4.4 Sending Component Version Information

Dostek DNC includes an application that reports the current version of all the software
components it uses.

To send a software component version information to Dostek:

1. Start the Dostek DNC Navigator application.

2. Select the Navigator's Test tab, and then click Version Information. The
Component Version Info window opens. It displays a list of all software
components and the current version of each.

3. In the Component Version Info window, click Copy to Clipboard. The version
information is copied to the Windows Clipboard.

4. Open a new e-mail message, and then paste the captured data into the e-mail
message.

Note:

› If Version Information is not visible in the Test tab, start the component version
application manually:

a) Open Windows Explorer.

b) Browse to the "C:\Dostek DNC" folder.

c) Locate and double-click the DComponentVersionInfo application.

› If the computer does not have an e-mail client installed, save the copy the
captured file to another computer by a removable drive or a shared network
folder.
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4.5 Sending BTR Configuration

The Dostek DNC Com Test Terminal application includes a feature to capture configu-
ration information from a Dostek Model 440A Behind-the-Tape Reader (BTR).

To send 440A BTR configuration information to Dostek:

1. Ensure the 440A BTR is not already in use. The BTR's 7-segment indicator
displays one of the following three symbols: 

2. Click Query in DTerminal's BTR440A menu. (Requires DTerminal version
2006.22A or later).  

DTerminal sends a series of commands to the 440A BTR to capture the configu-
ration information. The BTR indicates "C" (command mode) for a few seconds
during this process. The Results window opens with a list of the BTR configura-
tion information. 

3. Click Copy results to Windows Clipboard. The results are copied to the
Windows Clipboard.

4. Open a new e-mail message, and then paste the captured data into the e-mail
message.

Notes:

› To download the latest version of the DTerminal application, visit
www.dostek.com/support.htm and click the Support Update link.

› If the computer does not have an e-mail client installed, save the copy the
captured file to another computer by a removable drive or a shared network
folder.
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Appendix A - Disconnecting a Remote DNC Channels

This appendix explains how to disconnect a CNC channel in the Dostek DNC Remote
Server application so you can capture received data from the CNC using the Com Test
Terminal (DTerminal) application.

Capturing data received from the CNC is explained in Section 6, "Send Captured CNC
Output to Dostek."

When you are using the Dostek DNC Remote Server application (DRemote), you must
"disconnect" the CNC channel before you can capture data using DTerminal.

To disconnect the CNC channel:

1. Select the CNC whose data you wish to capture in the MultiPort DNC channel list:

The selected channel is highlighted.

2. On the DRemote menu, click Channel, and then Disconnect. The channel's
COM port is released (closed) so the port can be opened by the DTerminal
application.
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